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Introducción 
A medida que el uso de los ordenadores ha ido incrementándose, en las empresas e 

industrias se ha hecho patente la necesidad de que los usuarios de los diferentes equipos 
informáticos pudieran intercambiar información de forma eficiente. En un principio los 
“diskettes” eran la única forma en la que el personal encargado de un proyecto podía compartir 
datos relativos al mismo. Con el tiempo han aparecido otras alternativas, como las redes de 
área local, que posibilitan el intercambio de información de una forma más sencilla, 
consiguiéndose al mismo tiempo una eficiencia mayor. 

Las redes de área local permiten acceder a los ficheros almacenados en directorios 
compartidos en ordenadores de otros usuarios. También permiten centralizar el almacenamiento 
de ficheros de la empresa en uno o más servidores de ficheros, consiguiéndose así aumentar la 
eficacia a la hora de hacer copias de seguridad, o de actualizar el software empleado. Los 
servidores de ficheros también permiten el uso de bases de datos centralizadas, garantizándose 
de esta forma la coherencia de los datos almacenados. Por otra parte, a través de la red se puede 
trabajar de forma remota en otras máquinas a las que tengamos permitido el acceso. 

Aunque inicialmente las redes de área local se usaban únicamente para acceder a otras 
máquinas y a servidores de ficheros, con el tiempo se les ha ido añadiendo una serie de servicios 
como el correo electrónico, servidores de páginas web, servidores de noticias, etc. Estos 
servicios añadidos han dado lugar a lo que se conoce como intranets.  

A groso modo podríamos definir una intranet como una red a la que se le han 
añadido servicios típicos de Internet, con el fin de permitir a los miembros de una 
organización comunicarse y colaborar de forma eficaz. Otro nombre con el que 
comúnmente se les conoce es el de redes corporativas. 

Aunque Internet y las intranets comparten la misma tecnología, las principales 
diferencias entre ambas son la propiedad y el acceso. Efectivamente, a diferencia de Internet una 
intranet es una red privada, propiedad de la organización a la que sirve. Por otra parte, el acceso 
a una intranet no tiene por qué estar siempre permitido. A menudo no es posible acceder a la 
intranet desde fuera de la organización en la que está instalada. No obstante, la comunicación en 
el sentido opuesto generalmente está permitida: desde la intranet se puede acceder a Internet. 

En esta práctica vamos a instalar, configurar y gestionar una intranet en un entorno de 
trabajo basado en Windows 98. Para ello, dado que Windows 98 no incorpora la mayoría de los 
servicios habitualmente presentes en una intranet (servidor de correo electrónico, servidor de 
noticias, servidor ftp, servidor web, etc), vamos a utilizar un programa comercial, llamado 
NetNow,  para proveer a nuestra red de estos servicios. Este programa proporciona muchas 
posibilidades. Sin embargo, en esta práctica únicamente vamos a revisar aquellas directamente 
relacionadas con los servidores antes mencionados. 

Para la realización de la práctica es necesario organizarse en grupos de dos ordenadores, 
uno de los cuales hará de servidor de la intranet, y el otro utilizará los servicios proporcionados 
por el servidor. En esta práctica vamos a suponer que nuestra intranet no tiene conexión a 
Internet. 
 

Instalación y configuración de NetNow 
 Para la instalación de la aplicación 

NetNow se debe ejecutar el programa 
netnow5.exe que se encuentra disponible en el 
servidor herodes, en el directorio ”\\herodes 
\practicas\Gyurl\Practica5”. Este fichero 
se autodescomprime automáticamente al ser 
ejecutado. Cuando aparezca la ventana de la 
derecha, pulsad el botón “Unzip”. 
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 Una vez descomprimido, el programa de instalación 
arranca automáticamente, mostrándonos la ventana de 
bienvenida de la derecha. Para avanzar en la instalación hay 
que ir pulsando el botón “Next”, aceptando la opción por 
defecto. Cuando pida el número de serie del producto, 

dejadlo en blanco, 
ya que la versión 
que manejamos es 
de evaluación.  

 Tras la instalación del programa llegamos a la 
ventana que se muestra a la izquierda, con la que 
comienza el proceso de configuración de nuestra 
intranet. A partir de aquí vamos a ir configurando cada 
uno de los servicios de nuestro servidor, conforme a las 
ventanas que se muestran más abajo. 
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 Una vez hayamos instalado y configurado el programa NetNow, los servidores de 

correo electrónico, web y noticias estarán en marcha. Para acceder a ellos y acabar de configurar 
los diferentes servicios debemos hacerlo a través de la consola de NetNow. Podemos activar 
dicha consola de dos formas diferentes: a través del menú “Inicio -> Programas -> RedRock 
NetNow 5 -> NetNow Console”: 
 

 
... o bien haciendo doble click en el icono de NetNow 
de la barra de tareas, como  muestra en la figura de la 
derecha. En ambos casos se abre la ventana de la 
consola de NetNow, que se muestra en la figura de la 
página siguiente. Lo más destacable de la consola es la 
parte izquierda de la ventana, donde se presentan en 
forma de árbol los principales servicios de NetNow. 
Según el item seleccionado en el árbol de servicios, la 
parte derecha de la ventana mostrará unos contenidos u 
otros. En la figura de la consola de la página siguiente se muestran los servidores que están en 
marcha: el servidor de correo saliente (SMTP), el servidor de correo entrante (POP3), el 
servidor de noticias (NNTP), el servidor de web (HTTP) y los repartidores de correo. Por otra 
parte, ningún ordenador cliente está actualmente conectado al servidor de la intranet (columna 
“Connected To”). 
 
Ejercicio: Abre la consola de NetNow y comprueba que los servidores de correo, 
web y noticias están en marcha y que todavía no hay ningún cliente conectado. 
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 Para terminar con la introducción a NetNow, podemos acceder a las propiedades de 
nuestro servidor de la intranet en el menú “Options -> Server”. En la ventana que aparece 
podemos ver las diferentes opciones que hemos ido especificando en la etapa de configuración. 
Si fuera necesario podemos cambiar cualquiera de ellas. 
 

Configuración del servidor WEB 
 Antes de configurar el servidor web de nuestra intranet, debemos crear las páginas web 
que vamos a poner en el servidor. Como el objetivo de la práctica no es aprender a diseñar 
páginas web, se han preparado algunas de ejemplo, que podéis encontrar comprimidas en el 
fichero web.exe en el servidor herodes, en el directorio ”\\herodes\practicas\Gyurl  
\Practica5”. El fichero web.exe se autodescomprime en el directorio “c:\web”. En dicho 
directorio se han creado tres carpetas diferentes: una para la web general de la organización, otra 
para la web de un usuario cuyo nombre será usuario1 y otra para la web de otro usuario llamado 
usuario2. Una vez descomprimidas, debemos 
configurar el servidor. Para ello accederemos a la 
ventana de servicios, en el menú “Options -> 
Services” y seleccionaremos el servidor de web 
pinchando dos veces sobre él. Aparecerá la ventana de 
la derecha, donde debemos activar la casilla “WWW 
Server” para poner en marcha el servidor web. Una vez 
puesto en marcha se necesita especificar dónde están 
las páginas web que se van a publicar en el servidor. 
Esto lo hacemos pinchando en la solapa “WWW 
Server”. En esta solapa es necesario especificar dos 
parámetros: el primero es la situación en el disco duro 
de los ficheros que albergan las páginas web de nuestro 
servidor. En nuestro caso, todos los ficheros están 
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dentro de la carpeta “c:\web”. Este parámetro es el 
llamado “Root” en la pestaña del servidor. El segundo 
parámetro es la página de entrada a la web. Nuestra 
página de entrada va a ser “home.html”. Cuando desde 
un navegador se solicite dicha página, la página que hay 
que mostrar es la contenida en el fichero  
“c:\web\general\default.html”. Este fichero 
inicial depende de cómo se haya diseñado la página web. 
Para especificar estos parámetros hay que pinchar en el 
botón “Add”. Al final nos debe quedar una 
configuración como la de la derecha. Pulsad “OK” para 
que los cambios tengan efecto. 
 Falta comprobar que todo ha ido bien. Esto lo 
podemos hacer conectándonos al servidor desde uno de 
los ordenadores que estamos usando como clientes en nuestra intranet. La dirección web a la 
que hay que conectarse, si nuestro servidor tiene la dirección IP 158.42.58.2 sería: 
 

 
Ejercicio: Conectáos al servidor web de vuestra intranet desde cada uno de los 
dos clientes. Comprobad que el servidor web funciona correctamente.  
 
Ejercicio: Configurad el servidor web para que publique las páginas web de los 
usuarios 1 y 2. El fichero inicial para el usuario 1 es espanol.html y el del usuario 
2 es inicio.html. Aseguráos del correcto funcionamiento del servicio. 
 

Creación de usuarios 
Además de proveer servicios de web, en una intranet también es típico encontrar 

servicios de correo. Como es habitual, cuando un usuario quiera recoger su correo, el servidor 
debe saber quién es y pedirle la correspondiente contraseña. Además, el servidor también ha de 
ser capaz de distribuir el correo que llega entre los usuarios de la intranet, devolviendo aquellos 
correos cuyo destinatario no pertenece a la misma. Por todo ello, para proporcionar este tipo de 
servicios es necesario dar de alta a los usuarios de la 
intranet. 

El alta de nuevos usuarios se hace en la ventana 
del gestor de usuarios, a la que podemos acceder por el 
menú “Options -> Users”. En esta ventana debemos 
pinchar en el botón “Add” para crear un usuario nuevo. 
Para cada usuario debemos especificar un identificador 
de usuario, su nombre completo, su contraseña y el 
directorio donde se encuentra su página web. 

 
Ejercicio: Dad de alta a los dos usuarios de 
nuestra intranet, cuyos identificadores deben 
ser “usuario1” y usuario2”. 
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Configuración del servidor de correo 
Aunque es habitual que con la creación de un usuario se creen también todos los 

servicios asociados a ese usuario, en NetNow cada uno de los servicios se debe crear por 
separado. Por tanto, para configurar el servidor de correo lo primero que hay que hacer es crear 
las cuentas de correo de los usuarios de la intranet. La 
ventaja de crear por separado los usuarios y sus cuentas 
de correo es que a determinado grupo de usuarios 
podemos no crearles cuenta de correo. Esto es útil en 
ocasiones, cuando por ejemplo sólo queremos 
proporcionarles una página web personal. 

La creación de las cuentas de correo se hace a 
través del menú “File -> New -> User Mailbox”. 
Aparecerá una ventana como la de la derecha, donde 
debemos rellenar los diferentes campos. El primero de 
ellos hace referencia al nombre de la cuenta de correo 
(que puede ser diferente al nombre del usuario). El 
campo “Owner” se refiere al dueño de la cuenta de 
correo. Los campos en las otras pestañas de la ventana 
no son necesarios de momento. 

 
Ejercicio: Cread las cuentas de correo para los dos usuarios de la intranet. 
Configurad un gestor de correo (Outlook Express o Netscape) en la máquina 
cliente para acceder al servidor. Tened en cuenta que la dirección de correo 
será del estilo “usuario1@158.42.58.2” (en las figuras siguientes se muestra una 
posible configuración). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Probad a intercambiar varios mensajes. A medida que vayáis intercambiando 
mensajes,  observar la evolución del servidor de correo a través de la consola de 
NetNow (en el árbol de la izquierda, “Mail -> Mailboxes”).  
 
 
Cuestión: ¿Se puede ver el contenido de los mensajes almacenados en el 
servidor que están pendientes de ser recogidos por su destinatario? 
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Configuración del servidor de noticias 
Un servicio muy útil para el intercambio de información entre los usuarios de Internet es 

el servicio de noticias. Este servicio también se puede incorporar en una intranet, especialmente 
si el número de usuarios de la misma es elevado. Efectivamente, cuando el número de usuarios 
de la intranet es pequeño no se 
obtienen casi ventajas de un 
servicio de noticias. Sin embargo, 
cuando hay varios cientos de 
usuarios este servicio es 
tremendamente útil. 

Para proporcionar el 
servicio de noticias a los usuarios 
de nuestra intranet, lo primero que 
debemos hacer es crear los grupos 
de noticias, de forma que los 
usuarios puedan suscribirse a ellos. 
Para ello hay debemos acceder a la ventana de grupos de noticias a través del menú “Options    

-> Newsgroups”. En esta ventana 
podemos crear nuevos grupos de noticias 
pulsando el botón “Create”. En la ventana 
que aparece debemos dar nombre al grupo 
de noticias.  No hay que olvidar indicar que 
el grupo de noticias reside en el propio 
servidor. 

 
Ejercicio: Cread un par de grupos de 

noticias en el servidor de la intranet. Configurad un lector de noticias (Outlook 
Express o Netscape) en la máquina cliente para acceder al servicio recién 
creado, subscribiéndoos a los dos grupos de noticias. Enviad alguna noticia 
nueva a los grupos de noticias. A medida que vayáis intercambiando mensajes,  
observad la evolución del servidor de noticias a través de la consola de NetNow 
(en el árbol de la izquierda, “News -> Subscriptions -> Local Groups -> Grupo”).  
 

Configuración del servidor de FTP 
A la hora de prestar servicios de FTP es necesario especificar si el servicio se presta de 

forma general a un usuario anónimo, de forma que todos los usuarios de la intranet se conectan 
al servidor usando este usuario, o si cada usuario puede conectarse con su propio identificativo. 
Ambos tipos de sevicio no son excluyentes, y sirven a propósitos diferentes como veremos más 
adelante. En esta práctica 
vamos a prestar ambos 
tipos de servicios. 

Para prestar 
servicios de FTP hay que 
activar el servidor 
correspondiente, a través 
del gestor de servicios 
(menú “Options -> 
Services”). 
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En el gestor de servicios debemos pinchar con el 
ratón en el botón “Add” y seleccionar el servicio FTP. 
Una vez seleccionado debemos configurarlo. Para ello se 
abre automáticamente la ventana de configuración, en la 
que debemos habilitar el servidor. Por otra parte, en la 
pestaña “Server” debemos especificar el directorio 
“Root” del servicio, que es el directorio del disco duro 
donde entrarán los usuarios al conectarse al servidor. 
Como se puede ver, el programa nos propone el 
directorio “C:\ARCHIVOS_DE_PROGRAMA\NETNOW\ 
database\ftproot\”. Podemos quedarnos con este 
directorio, pero hay que comprobar si realmente existe, y 
si no existe, debemos crearlo. 

Una vez hemos configurado el servicio debemos 
activar el servidor (“Tools -> Start Service -> FTP File 
Transfer Server”) y definir los puntos de entrada al 
servicio para cada uno de los usuarios. En el caso del 
usuario “anonymous”, su punto de entrada será el 
directorio que hemos especificado en la ventana de 
propiedades del servidor. Esto lo debemos configurar en 
la ventana del gestor de usuarios (“Options -> Users”), 
pinchando en el botón “Guests”. En la ventana de 
propiedades del usuario “Guest”, en la pestaña “Web 
Services” debemos habilitar las opciones “Allow Login” 
y “Upload/Modify”. 

Por otra parte, para definir que los usuarios 
registrados entren cada uno en su propio directorio, 
además de habilitar las opciones antes mencionadas 
debemos habilitar también la opción “Login to 
Homepage directory” en la ventana de propiedades del 
usuario correspondiente. 
 
Ejercicio: Configurad el servidor de FTP de acuerdo a lo mencionado en los 
párrafos anteriores. Copiad algún fichero al directorio definido como “Root” del 
servicio, y conectáos de forma anónima, comprobando que podeis bajaros dicho 
fichero. Tratad de guardar algún fichero en el servidor. 
 
Ejercicio: Conectáos al servidor FTP utilizando los identificadores de usuario 
“usuario1” y “usuario2”. ¿Qué información estáis viendo con cada identificador? 
¿Es la misma? ¿Podéis acceder a la información de otro usuario? 
 
Cuestión: ¿Cuándo tiene ventajas conectarse al servidor FTP de forma anónima 
y cuándo tiene ventajas hacerlo usando un identificador de usuario? 
 
 


